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Welcome! 
Our Introduction course will hopefully have equipped you with the skills to get going with 

word processing, but this Intermediate course will take you onto the next stage.  The course 

covers more involved features and looks at using the more advanced elements of some of 

the features you will have already experienced. 

This IT Training course will show you how to: 

• Create complex tables 

• Apply Tabs and Indents 

• Work with Templates 

• Use sections for Headers, Footers and Page numbering 

• Insert a Table of Contents 

• Work with Pictures 

• Insert Hyperlinks 

• Insert Footnotes and Endnotes 

• Use Track Changes and Protect Documents 

If you have been using Word for a while, we hope these notes will help you upgrade your 

skills and knowledge and take advantage of the features offered by Microsoft Word. 

To help you, you will find the following symbols used throughout this guide: 

This symbol will indicate information that you need to be aware of, tips and tricks and occasionally, things to watch 

out for to avoid problems. 

 
This symbol will be shown when you need to take care and pay attention to what you are doing to avoid 
creating problems for yourself. 

 

Best wishes 

IT Training Team (Cheshire) 

IT Services, Midlands and Lancashire CSU 

 

Contact 

Email: csu.ittraining@nhs.net 

Telephone:  01606 544468 

 

  

mailto:csu.ittraining@nhs.net
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Complex Tables 
These notes assume that you are comfortable with creating a simple table using the 

techniques covered in the Word Introduction course. 

Selecting Rows, Columns and Cells 

Cells 

Point to the left of the cell until the selection arrow appears.  Click to 

select the cell.    

Rows 

Point to the left of the cell at the beginning of the row until the 

selection arrow appears.  Click to select the cell and drag over 

other cells with this symbol to select the row. (Alternatively try 

using the selection point for a line in the left-hand margin of the document.) 

Columns 

To select a column, place the I beam on the top line of the column 

and the selection arrow will appear.  Click the mouse.  To select 

multiple columns, hold down the mouse and drag over the columns 

required. 

Table 

To select the whole table, click the  symbol that appears when you point at the table. 

Changing Column Width 

To alter the column width, point the right-hand column border to display the resize tool 

Drag the border to the required width.  Alternatively, double click to have Word autofit the 

width of the column to the widest entry in that column. 

Changing Row Height 

To alter the row height, point to the bottom border of the row to display the resize tool  

Drag the border to the required depth. 

Heading rows repeat 

If you create a table that extends across two or more pages, the headings at the top of the 

table can be automatically repeated at the top of each page, as long as you have not split 

the table. 

To do this, select the row of cells at the top of the table and click the Layout ribbon and 

click Repeat Header Rows.   
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The headings will now appear automatically as your table extends over each page.  If you 

want to edit the headings, edit the headings at the very top of the table. 

Splitting 

Splitting a Table 

If you have created a table and then decide the information would be better displayed in two 

separate tables, click in the left most column of the first row that you want to appear in a 

separate table and click the Layout ribbon, click Split Table.  

In the example the table has been split between the third and fourth rows. 

 

 

 

Splitting Cells 

Splitting cells can create more complex designs.  Select the cell you want to split and click 

the Layout ribbon and click Split Cells.   

Enter the number of columns and/or rows that you require and click OK.  

 

 

 

 

 

In the example below, the original table is displayed on the left and in the table on the right 

the cell beneath the Chester cell has been split into three columns.  

 

In the example below, the cell beneath the Macclesfield cell has been split into three rows.  
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Resizing a Table 

Word offers a new way to alter the look of a table using the Table Resize handle.  If you 

drag the handle (see diagram) the dimensions of the table will be altered.  This is a quick 

and easy way to make minor adjustments or radical changes to the look and feel of your 

table. 

In the example, the resize handle was used to quickly alter the table dimensions from a 

rectangle to a square. 

 

Gridlines show/hide 

When you create a table, the gridlines are visible, even if you remove the 

borders from the table.  If you want to hide the gridlines from view, click the 

Layout tab and click View Gridlines.  

To restore them click the View Gridlines button again.   

In the example below, on the left gridlines are visible.  On the right gridlines have been 

hidden: 

  

Table Ribbons 

The Table Design and Layout ribbons are activated when you click on a table 

Table Design Ribbon 

Use this ribbon to change the style and colours of the table. 

 

Table Styles Options 

Select the relevant ticks in the Table Styles Options group to adjust the settings. 

Table Styles 

Hover over the available Table Styles to preview the changes to the table.  Click the Style 

to apply the changes. 
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Shading 

Highlight the cells, rows or columns in the table and click the arrow to 

the side of the Shading icon.  Hover over the colour to preview the 

changes and click to apply. 

Click More Colors at the bottom of the menu for more colour options. 

 

 

Borders 

Highlight the cells, rows or columns in the table and click the arrow to 

the side of the Borders icon.  Click each border option to turn the 

border on or off.  

Click Borders and Shading at the bottom of the menu to view the 

Borders and Shadings dialog box. 

Select the Style, Colour and Width.  Click the borders buttons in the preview window to 

apply the changes. 

Click OK to confirm. 

 

Draw Table 

Draw Table provides the ability to define the shape and dimensions of a 

table by drawing it rather than by specifying a set number of columns 

and rows.  Select the Insert tab, select Table and click 

.  Use the pencil to drag out the overall shape of 

the table.  Release the mouse when the desired size is displayed. 

 

Next, use the pencil to draw in the lines that you require to make up 

the structure of the table.   
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Note: Word will attempt to assist you as you draw straight lines by extending your line to the edge of the table 
automatically once you have drawn to the half-way point. 

 

The example shows some of the complexities that can be created using Draw table. 

 
 
 
 
 
 
 
 
 

Draw Table Eraser 

The Draw Table Eraser can be used to remove lines that you no longer require.  Click the 

table to activate the Table ribbons, select the Layout tab and click  .   

Click on the lines you no longer require.  

 

 

 

Draw Table Line Style, Weight and Border Colour 

Adjust these options then click on the line(s) you want to format and the 

formatting will happen instantly.   

Layout Ribbon 

Use this ribbon to adjust the cells, rows and columns of the table. 

 

Select 

Use the Select option to highlight the different parts of the table 

Properties 

The Table Properties dialog box holds a wide variety of useful features that you may need 

from time to time: 
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Table Size 

Select the table and use the Size feature to specify the preferred width of the table in 

centimetres or as a percentage of the typing line.  Simply tick the box and adjust as 

required. 

Table Alignment 

Select the table and use the Alignment option to specify the position of the table on the 

page, i.e., Left, Centre or Right.  Alternatively adjust the Indent from left box to specify the 

amount you want the table indented from the left-hand margin. 

Table Text Wrapping 

By default, text does not wrap around the outside of tables. To change this, select the table 

click the Text Wrapping and click the Around option to have any text wrap around the 

table. 

This example text has been entered next to the table because the table text wrapping has 

been set to Around. 

 

 

 

Example Of 

Text  Wrapping 
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By default the table will move with the text if additional text is 

added to the document above it, however if you want to fix the 

table on to the page, chose the Positioning button to fix the 

table in place.   

You can specify the position both vertically and horizontally 

and also adjust the distance that is to be left by any text 

wrapping around the box.  The option Move with Text should 

be un-ticked if you wish to fix the table in its current position.  

 

 

Table Spacing 

The Table Options button provides the ability to customise 

the cell margins and the spacing between cells.  You can 

also switch off the automatic resizing to fit contents feature 

if required. 

Row Size 

The Row size can be customised by specifying the required 

height.  The height can be set exactly or a minimum height 

can be specified. 

Row Options 

The option to allow a row to break across pages is on by default.  This is not always 

attractive or desirable in long tables and switching it off will force the whole row to move to 

the next page. 

Click the Previous Row and Next Row button to move through the individual rows to 

adjust the options.  The row number will be displayed in the top left. 

The ability to repeat a row as a heading at the top of each page is offered as an alternative 

to the Repeat Header Rows option. 
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Column Size 

Column size can be used in a similar way to Table 

size.  Specify the required width using either 

centimetres or a percentage of the typing line.  

Click the Previous Column and Next Column button 

to move through the individual columns to adjust the 

options.  The row number will be displayed in the top 

left. 

 

 

 

Cell Size 

Cell size can be used to alter the width of the cell in 

either centimetres or as a percentage of the width of 

the table row.   

Vertical Alignment 

This is a useful feature for adjusting the position of 

text within a cell from the default of Top to Centre or 

Bottom. 

 

 

 

Cell Options 

The Cell Options button offers the ability to alter the margins of 

individual cells, turn text wrapping within the cell on or off and also 

to switch on the Fit Text feature. 

 

Change Text Direction 

Select the cell(s) containing the text that you want to 

change the direction of.  Click Text Direction.    

Click the button repeatedly until the desired text direction is 

displayed.  

Note:  Changing the text direction can alter the dimensions of your table so you 

may need to adjust the table after you have altered the direction.  
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Convert Text to a Table 

Text can be converted to a table quite easily.  Simply select the text and Insert tab, click 

Table and Convert Text to Table.  From the dialog box adjust the settings and click OK.  

 

 

 

 

 

 

 

 

 

Table Size 

Word should identify how many columns and rows are required, but you can alter if 

required. 

Autofit Behaviour 

Set the behaviour that you require. 

Separate text at 

Select how you want the text to be separated into cells. 

 
 

In the example below, the text was entered using tabs in between each column.  The 

Show/Hide feature has been turned on to show the tabs: 
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This text has been converted into a table using the Separate text at Tabs option: 

 

Convert a table to text 

To convert a table into text, select the table and choose the Layout tab   

Click Convert to Text.  Specify how to separate the text and click OK.  

 

Sorting in a Table 

Data typed into a table can be sorted into either ascending or descending order.  Word 

automatically defaults that the top row is set to a Header Row.  This can be changed in the 

My List Has section at the bottom of the dialog box. Select the table and choose the 

Layout tab.  Click  to display the Sort dialog box, adjust the settings to select the sort 

required.  Click OK. 
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Sort by 

The headings from the top of the table should be listed in this box.  Select the heading for 

the column of data that you want to sort the data table by. 

Type 

Specify if you are sorting text, numbers or dates.  This will automatically adjust as Word will 

recognise the content of the cells. 

Sort Order 

Specify Ascending or Descending as required. 

Formulae in Tables 

Mathematical formulae can be inserted into tables that contain figures to perform 

calculations.   

 

In the example above, the total price column needs to be totalled.   

Word views your table like a mini spreadsheet and labels the cells of the table using letters 

for each column and numbers for each row.  This hidden naming of the cells within a table 

would look like this if you could see them: 

 

To enter a calculation, position the insertion point in the cell where you want the result of 

the formula to appear.  Choose the Layout tab from the Table Tools options.  

Click Formula. 

Enter the formula required or accept the default, then alter 

the number format if required and click OK.  

 

In the example above the =Sum Function from Excel is identified as appropriate in this 

example and Word suggests that you want to add up (Sum) the cells immediately (ABOVE) 

the cell you had selected.  We altered the number format to automatically include a £ sign 

and two decimal places.   



 

NHS Midlands & Lancashire Commissioning Support Unit 18 

To identify which figures are calculations and which are simply numbers that you have 

typed, click into the cells.  Any number that is immediately shaded is the result of a Table 

Formula. 

To write a formula in the table to calculate the VAT the following was entered in the Table 

Formula Box: 

 

We then repeated the formula on the remaining two lines in column C, changing the B2 to 

B3 and B4 appropriately: 

 

For the Total in column D, the following function was automatically entered by Word.   

However, when we attempted to repeat the command for Row 3, the function suggested by 

Word was =SUM(ABOVE).  We edited the word ABOVE to read LEFT and repeated this for 

Row 4.   

 

Alternatively, we could have copied the original Sum Function to the other cells and use the 

Formula Recalculate feature in each cell to recalculate the answer. 
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Table Formulae and Functions 

If you are familiar with writing formulae in spreadsheets you can use the normal syntax and 

operators in a Word Table that you would use in Excel.  The following Functions are also 

available: 

ABS IF OR 

AND INT PRODUCT 

AVERAGE MAX ROUND 

COUNT MIN SIGN 

DEFINED MOD SUM 

FALSE NOT TRUE 

For further information, please refer to our Excel guidebooks. 

Formula Recalculate 

If the figures that relate to your calculation change or you have moved or copied a function 

within your table, select the cell containing the effected formula and press F9.  The 

formula/function will recalculate: 

 

In the example above, the Price of the Chair was altered to £150.  The cell C2 was selected 

and F9 pressed to recalculate.  To recalculate the Total for the line it would be necessary to 

select the cell D2 and press F9 again. 

You can also use right click and select Update Field. 
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Tabs 
Word has default tabs that are visible on the bottom edge of the horizontal ruler.  Each time 

the tab key is pressed the insertion point jumps to the next tab location: 

If the Show/Hide feature is on, the tab is represented by a small arrow . 

Setting Tabs 

The default tabs can be replaced with tabs of your own choice either by using the Ruler or 

by using the opening the Paragraph dialog box and clicking Tabs. 

Using the Ruler 

If the Ruler is now displayed, click the View tab and tick the box to view 

the Ruler.  Select the text or position the insertion point on the line that 

you want to contain tabs.  Click the Tab Alignment button  on the left 

edge of the Ruler to select the tab type required:   

 Left 

 Centre 

 Right 

 Decimal 
 

Once displayed, point at the place on the Ruler where you want to set the tab and click the 

mouse.  The tab symbol for the tab type chosen will appear.     

 

In the example above all four types of tab were set, and when the tab key is pressed so that 

the insertion point is beneath the tab any text that is typed will be aligned according to the 

tab type, i.e. left, centre, right or at the decimal point. 

To move a tab stop, click it and drag it to the required location. 

To remove a tab stop, click it and drag it off the Ruler. 

Using the Tabs dialog box 

The Tabs dialog box can be used to set up the four different types of tabs, but also offers 

other features.  From the Home ribbon, click the dialog box launcher button in the 

Paragraph group. .  Click Tabs in the bottom left corner. 
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To set a tab, enter the position for the required tab stop, select the Alignment style require 

and click Set.  Repeat as required.  

To clear a tab, click on its position in the Tab Stop Position list and click Clear.  To clear 

all the tabs and restore the default tabs click Clear All. 

 

 

 

 

 

 

 

 

 

Bar Alignment 

Bar Alignment places a vertical bar the length of the paragraph at the position of the tab 

stop: 

In the example, three tabs were set at 2cm, 5cm and 5.5cm.  The tab at 5cm was a bar tab. 

 

 

 

Leaders 

Leaders are dots or dashes that lead the eye from one item to another in a tabulated list. 

In the example, two tabs were set at 2cm and 5.5cm.  The tab at 5.5cm was formatted as a 

leader tab. 

  



 

NHS Midlands & Lancashire Commissioning Support Unit 22 

Indents and Hanging Indents 
In the Word Introduction course we introduced the idea of using paragraph indents with the 

 decrease/increase indent buttons from the Home ribbon, Paragraph group.  This 

section will take your knowledge of indents further using the Ruler to set them up and 

introduce you to Hanging Indents. 

What is a Hanging Indent/Paragraph? 

A Hanging indent/paragraph is usually a numbered or lettered paragraph where the body of 

the paragraph hangs away (or is indented) from the left edge of the margin.  

For example:  In paragraph 1. below, the number 1 was typed and then tab pressed.  As 

the paragraph was typed, the second line reverted back to the left-hand margin.  In 

paragraph 2, a hanging indent was created to ensure that the second line of text wrapped 

around at the indent from the previous line. 

1. CSU ICT Service offers a variety of courses on Microsoft products and Health Information 

systems. 

2. CSU ICT Service offers a variety of courses on Microsoft products and Health Information 

systems. 

Ruler Symbols 

The symbols found on the Ruler all work together but they each have their own area that 

they control.  You can drag them along the Ruler independently or together to create a 

desired effect: 

Symbol Action 

 
First Line Indent:  A paragraph’s first line of text 

begins at this symbol. 

 
Hanging Indent:  A paragraph’s second and 

subsequent lines of text begin at this symbol. 

 Left Indent:  Text indents to this symbol 

 
Right Indent:  Text wraps to the next line when it 

reaches this symbol. 

Creating a Hanging Indent 

When you click  to indent the left margin, the First Line Indent, Hanging Indent and Left 

Indent symbols all move along the margin to the next available tab stop.   
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If you want to create a hanging indent, you then need to move the First Line Indent back to 

the left-hand margin.  Do this by dragging the First Line Indent symbol.  .   

If you find this too fiddly, try pressing CTRL T.  This will automatically create a hanging 

indent, and repeated pressing of CTRL T will widen the space between the First Line Indent 

and the Hanging Indent.  Press CTRL SHIFT T will reduce the space between the First Line 

Indent and the Hanging Indent symbols. 

Got in a real mess with this?  Select the paragraph(s) where it has all gone wrong and try pressing CTRL SHIFT N 
to restore the Ruler symbols back to normal! 
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Templates 
A template is a file that contains formatting structure, styles and other features that help you 

to create a specific type of document such as a memo or form.   Word comes with a series 

of default templates, the most important being the Normal template upon which all blank 

documents that you create are based. 

Using a Template 

To access the Templates installed on your computer, click File and New from the left side 

of the screen.  

 

 

You can Search for Online Templates or click on a Suggested Search.   

 

Select a template to use and click Create.  A new document is created based on the 

template, keeping the template safe for repeated use without the worry of changing it. 

Choosing Blank document will create a new document based on the Normal template.   
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Creating a personal document template 

Create a document as normal, entering any standard text and applying any formatting 

(including setting up styles) as required.  When the document is ready to be saved, choose 

File, Save As and click Browse.  Select Microsoft Word in the navigation pane on the left, 

type a name for the template, then change the file type to Word Template. 

Alternatively, click your OneDrive, select the folder Custom Office Templates on the right 

of the screen and type a name for the template, then change the file type to Word 

Template. 

 

Click Save and close the file. 

Creating a shared document template 

Create a document as detailed above.  When the document is ready to be saved, choose 

File, Save As and click Browse.  Select OneDrive or This PC to view the Network Drive 

in the navigation pane on the left, type a name for the template, then change the file type to 

Word Template. 
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Using a personal document template 

Open Word, click File and select New on the left of the window.  Click Personal on the 

right to view your saved templated.  Double click the template to create a new blank 

document.   

 

Using a shared document template 

Navigate to the File Explorer using the yellow folder on the Task Bar  

or click the Start button and click the Documents icon. 

Open your OneDrive or Network Drive.  Double click on the template to 

create a new document. 

 

Editing a template 

Sometimes you need to edit a template you have created.  Create a new document with 

your existing template from the Personal templates, OneDrive or Network Drive. 

Make any relevant changes and click File, Save As and Browse to the location where the 

template is saved.  Ensure the document name is the same then change the file type to 

Word Template.   

Click Save.  A message will be displayed to confirm the file already exists, click OK to 

overwrite the file.  Close the document. 

 



 

NHS Midlands & Lancashire Commissioning Support Unit 27 

Headers and Footers 
Headers and Footers are lines of text that appear in the top and bottom margin of the page 

respectively and can be set up to cover the whole document or only parts of a document.  

The great thing about Headers and Footers is that you only type the text once and Word 

repeats it on every page for you automatically. 

Creating simple Headers or Footers 

Navigate to the Insert tab and click either Header or Footer.  Click Edit 

Header or Edit Footer at the bottom of the menu options.  Alternatively, double 

click in the Header or Footer area. 

 

Type the text that you want to appear on each page above the dotted line.  To display the 

Footer area, click  from the Header & Footer Tools ribbon to switch between the 

areas. 

Once you have typed the text you require, you can format it using all the normal formatting 

methods that Word offers.   

In addition, the following information can be added using the Header & Footer ribbon: 

 

When complete, click  button or double click into the document area.  To view the 

effect of your header/footer on your document, click Print or scroll through your document. 
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Different First Page 

The different first page option for headers and footers provides the ability to create a 

different header/footer for the first page of a document.  This can be good for long letters 

and reports where you don’t want the header/footer and page numbering to appear on the 

first page.   

Navigate to the Insert tab, click Header and select Edit Header from the options. 

From the Header & Footer Tools ribbon click the tick box Different First Page. 

 

In the document, use the Previous/Next buttons on the Header & Footer 

Tools ribbon to view the different header/footer areas for the first page and 

the remainder of the document. 

Different Odd and Even 

If you are going to print a document double sided (like this guide) it can be useful to have 

different headers and footers on each odd and even page. (Look at the footers at the 

bottom of this page and the next page.  You will see that we have used this odd/even 

feature to alter the position of the page number on each page so that it is always on the 

outside edge.) 

Navigate to the Insert tab, click Footer and select Edit Footer 

from the options.  

From the Header & Footer Tools ribbon click the tick box 

Different Odd & Even Pages. 

 

Page Numbering 

Page numbers can be added to a header or 

footer using the Header & Footer Tools or 

Insert ribbon. 

Click Page Number.  Hover over the menu 

options to display the available Page 

Number styles.  Click to insert the Page 

Number. 
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Formatting Page Numbers 

Navigate to the Insert tab, click Page Number and select Format 

Page Numbers to access the page number formatting dialog box.  This 

can also be accessed from the same icon in the Header & Footer 

Tools. 

Alter the Number Format from Arabic to Roman numerals or to letters.   

 

If you want the page numbering to start at a number other than 1, 

choose the Start at option and enter the number required.  Click OK when done. 
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Pages and Sections 
Pages and sections of a long document can be controlled using page breaks and section 

breaks. 

Word automatically works out when a new page is required as you type and creates new 

pages by inserting soft page breaks as you finish each page.   However sometimes you 

want to finish a page before you have typed to the end of it.   

Inserting Page Breaks 

Page breaks that you insert are known as Manual Page breaks.  Position the insertion point 

where you want the new page to start.   

To insert a manual page break navigate to the Insert tab and click Page 

Break button.  Alternatively press CTRL ENTER to insert the manual page 

break using the keyboard. 

In Print Layout View the new page will be obvious, but you can also see the page break 

when you use the Show/Hide option.  Page breaks are represented by a dotted line: 

 

Deleting a Page Break 

To remove a page break that you have entered, use the Show/Hide option to display the 

page break and then select the page break line and press Delete on the keyboard. 

 

Section Breaks 

At first glance a Section break can look like a page break, but it 

can be used to break a document at the point at which you want 

to do one or more of the following actions within the same file: 

Change the paper size, orientations or page margins 

• Create Newspaper style columns 

• Change the format, location and order of Page Numbers 

• Alter the contents of header/footers 

• Alter the vertical alignment of text on the page. 

 

Inserting Section Breaks 

To insert a Section Break, position the insertion point where you 

want the break to occur and navigate to the Layout tab, click 

Breaks:  
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Next Page:  Use this to have your new section separated at the insertion point by a manual 

page break. 

Continuous:  Use this option to create a new section on the current page.  This can be 

useful if you want to combine columns on a page of full margin to margin text. 

Even/Odd Page:  This option is useful when you intend to print on both sides of the paper 

as it will force a section break to the next even or odd numbered page. 

When you have inserted section breaks within a document you can tell which section you 

are currently in by looking on the Status bar.    The current page number 

is shown (according to what you have set it to start at) and the current section number.  

Right click the Status Bar to customize the Status Bar and turn the Section option on. 

In this example, we have inserted a next page section break beneath the second paragraph 

on page one (section one).  Then we clicked on to page two (section two) and changed the 

Page Setup to landscape. 

 

 

 

 

 

 

 

 

In this second example, we have inserted a continuous section break beneath the second 

paragraph and then altered the page setup to display the text from that point on in columns:  
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Managing Headers/Footers and Page numbering across Section 

Page Breaks 

When you insert a Next Page Section break, if you are using headers, footers and page 

numbering all the information for these items will be automatically setup to continue for the 

next section.  However, if your new section is to be landscape or if the page numbers need 

to be restarted you will need to edit the Headers/Footers and Page numbering for that 

section. 

In the example below we have created three pages.  The first page was created as a Title 

page and has had its Page Setup page layout changed to be Centered.  A section break 

was then added and the Page Setup page layout changed back to Top. The contents list for 

the document was typed.  A section break was then added to create section three and the 

text for the document was entered. 

 

Page numbers are not required for sections 1 or 2 but section 3 requires page numbers 

with the page numbers starting at Page 1.  A header is required for sections 2 and 3, but 

not for section 1. 

Editing a Section Header/footer 

Click on to a page within the section that you want to edit (in the case of the above example 

Section 3), and navigate to the Insert tab, click Header button and select Edit Header: 

 

The Header area displays and indicates in the top left-hand corner which section the 

header belongs to.  In the top right-hand corner, the prompt Same as Previous is shown.  

This is indicating that at present any editing that is done will affect the previous section(s).  

Enter the text required. 
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Looking at Other Section Headers/Footers 

To look at the content of the other section headers/footers, click Previous or 

Next to look at previous section headers/footers.  

In the example, the text The Art of Letter Writing was typed into Header Section 3.  Clicking 

the button shows that the text has also appeared in section 2 and section 1. 

   

 

Breaking the Link between section headers/footers 

If you don’t want the text you enter in the different section headers/footers to automatically 

change the other sections in the document you need to break the links between them.  

Each header/footer is linked to the previous section header/footer.  To break this link, click 

the Link to Previous  button on the Header & Footer Tools ribbon.  The text 

Same as Previous will disappear from the top right-hand corner of the header you are in.   

You can now edit this section header and any changes will only affect following section 

headers but not previous section headers. 

In the example, the Link between Section 1 and 2 was broken, by selecting Header Section 

2 and clicking .  It was then possible to edit the section 1 header and delete 

the header text. 
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Editing Page numbers across sections 

By default Word will number each page with consecutive numbers, start with page 1.  If you 

want to alter the page numbering so that the number that appears in your header or footer 

is not the physical page number for the document you need to insert a section break where 

the page numbering is to be altered. 

In the example we want to change page three to be numbered as Page 1.   

Edit the section header/footer and click  to break the link between the 

current section and the previous section footers.  Insert the Page Number and format as 

required.  Click Page Number, Format Page Numbers.  Choose the option Start At and 

enter the page number that you want page numbering to commence at.  Click OK.   

In the example, we edited the Section 3 Footer and clicked   to break the 

link between section 3 and the previous sections.  We then inserted the page number and 

altered the page number format to Start at Page number 1.   
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Creating a Table of Contents 
Tables of contents normally appear at the beginning of a long document and list the main 

headings and subheadings along with page numbers.  Word can generate a table of 

contents quickly as easily for you if you use the Heading Styles Heading 1 – 9. 

 

First, format the document that requires a table of content by applying Heading Styles 1 to 9 

as appropriate to the text.  Next, position the Insertion Point where you want the Table of 

Contents to appear and choose References, Table of Contents and select one of the 

Automatic Tables from the menu. 

 

 

Alternatively, you can select different formats.  Choose References, Table of Contents 

and select Custom Table of Contents from the bottom of the menu options. 

The Print Preview window will display how 

your table of contents will look. 

Change the Formats as required using the 

page number and tab leader options.    

Word comes with six different TOC styles.   

Next select how many heading levels you 

require in your Table of Contents.   

Click OK to generate the table. 

 

 

 

Note:  It is advisable to put the Table of Contents on a new page.  If you want to enter a heading such as “Contents”, avoid 

using a Heading style to format it or else this heading will be included in the table!  Format it after you have generated the 

Table! 
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Updating a Table of Contents 

If you change the document and need to update the Table of Contents, click on to any line 

in the Table, right click and select Update Field.  You may be prompted to select what you 

want to update, select Update entire table and click OK. 

 

    

Note:  If you find the page numbering is not working as you want it to, consider putting the table of contents in a 

section on its own and restarting the page numbering for the document at the section where the document text 

actually starts.  E.g. Page 1 is your Title Page (section 1) with no page numbering; Page 2 is your Table of 

Contents Page (section 2) with no page numbers; Page 3 is the start of the document (section 3) with page numbering 

starting at 1 for this section. 
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Inserting Hyperlinks 

A Hyperlink (link) appears on screen usually as a highlighted word, icon or graphic.  By 

moving the cursor over the item and clicking on the link additional information can be 

accessed.  Hyperlinks can be embedded into Word documents and can link to another part 

of the same document, another document or a web site.   

To follow a hyperlink within a Word document, hold down CTRL and click the 

Hyperlinked text or item. 

To insert a Hyperlink, choose Insert, Links and select Link from the options.  

 

Hyperlink to a website 

To insert a Hyperlink to a website, click .  In the Address box either 

select a previously visited web site from the drop-down Address box or copy 

and paste the URL (web address).  In the Text to display box enter the text that 

you want to appear in the document as the Hyperlink. 

 

In the example above we have created link text that states, BBC News Website and 

entered the Address of http://www.bbc.co.uk/news.   

 

Hyperlink to an existing file 

Please Note: You can only use this option for internal documents only.  You will have to 

give permissions if using a file from your OneDrive or the users will need access to the file 

on the Network Drive.  To insert a Hyperlink to an Existing File, click .   
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In the Text to display box enter the text that you want to appear in the document as the 

Hyperlink.   

Click the Look in drop-down list or click the Browse icon to navigate to the document 

location and click the document to highlight it.   

 

Click ScreenTip in the top right corner and type in the text that will be displayed when the 

user hovers over the hyperlink.  Click OK. 

 

Click OK when finished. 

 

In the example above we have created a link to the Manage Rules in NHSmail document 

and when you hover over the hyperlink the screen tip will be displayed. 

Hyperlink within the current document 

To create a link to a place within the current document, click  in the Link To bar. 

Enter the Text to display as the Hyperlink.  Next select the place in the document that you 

want to link to, i.e. a heading.  Click OK. 
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In the example above we have created a link to the Templates heading within the current 

document. 

Target Frame 

A Target Frame controls how the linked 

information appears on screen.  Select New 

Window for links to Websites and click OK. 

Click OK to complete the setting up of the 

Hyperlink. 

 

 

For guidance on the use of other Target Frames, please refer to the table below: 

Target Frame Purpose 

Page Default 

(none) 

Used for links within the current document 

or another document only 

Same Frame Used When creating HTML Web pages 

only. 

Whole Page Used for links within the current document 

or another document only 

New Window Displays the website in a new Window 

Parent Frame Used when creating HTML Web pages 

only 

Editing Hyperlinks 

To edit a Hyperlink, right mouse click on the Hyperlink and choose Edit Hyperlink. 

 

Removing Hyperlinks 

To remove a Hyperlink, right mouse click on it and select Remove Hyperlink. 
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Copying Hyperlinks 

If you need to select a hyperlink so you can move it or copy it, it can be quite tricky to select 

them just by using the mouse as often you will not quite get all the text.  To make it easy, 

right click on the hyperlink and choose Copy Hyperlink. 

Quick Create Hyperlinks 

You can create some types of Hyperlinks automatically, for example if you enter a web 

address it will be automatically converted into a Hyperlink when you press Enter on the 

keyboard.  Use Edit Hyperlink to change the Text to Display or add a Screen Tip for 

example. 

Using graphics or symbols as Hyperlinks 

If you want to use graphics or symbols as Hyperlinks, insert the graphic or symbol into your 

document then select it and choose Insert, Links and Link.  Set up the Hyperlink as 

required and click OK.  The symbol or graphic will now be a hyperlink. 

 

Email Address Hyperlink 

This option will allow you to click the Hyperlink to generate a new email.  In order for this to 

work the user will need to have an Outlook account set up and the program open before 

they click the hyperlink. 
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Using Footnotes 
Footnotes appear at the bottom of a page containing associated text.  A footnote consists of 

two elements a Reference Mark and Note Text.  

Position the insertion point where you want the Reference Mark to appear and choose 

References, Insert Footnote. By default Footnotes appear at the bottom of the page 

although you can alter this to Below Text.   

The Reference Mark (number) will be inserted at the Insertion 

Point and you will be placed ready to enter the Note Text at 

the foot of the page.   

 

 

Notice the Separator line above which clearly shows that the Note is not part of the full text. 

Click the dialog box launcher button in the Footnotes group to 

change the formatting options for the footnote numbering style as 

required or select a symbol that you want to use. 

 

To remove a Footnote, select the Reference Mark and delete it.  

The associated Note Text will be automatically deleted from the 

foot of the page. 

Using Endnotes 
An Endnote is like a Footnote but appears at either the end of a document or at the end of a 

document section.  Endnotes also consist of Reference Marks and Note Text. 

Position the insertion point where you want the Endnote Reference Mark (roman numeral) 

to appear and choose References, Insert Endnote.  You will be taken to the Endnotes 

location so that you can enter the Note Text.   

Repeat as required.  E.g. 

 

End notes at the end of the document: 

 

 

 

Notice that by default the numbering system is Roman Numerals whereas the system for 

Footnotes is numbers.   
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Pictures 
You can insert saved or online pictures.  Online Pictures are photographs and images (usually 

copyright free) that can be incorporated into Office products. 

Inserting an Online Picture 

Position the insertion point at the point where you want the image to be inserted, navigate 

to the Insert tab and click .  A new window will open: 

  

Enter a word into the Search box that describes the idea you want a representative image 

of and click the magnifying glass: 

 

The images found will be displayed.  Use the drop-down menus to filter the images Size, 

Type, Color or Layout.  Click the image that you require and click Insert.   

Inserting Saved Pictures 

If you have images or pictures that you want to add to a document that you have stored on 

your computer or network drive(s), and click  from the Insert tab.  The Insert 

Picture dialog box will be displayed.  Locate the picture required and click Insert.  The 

image will now appear as an object in your document.   
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Manipulating Pictures 

Once you have inserted the Picture you need to be able to manipulate it to behave as you 

require.   

Text wrapping 

Initially when the image is inserted it behaves as if it is a single character and may 

dramatically alter the line height of the line of text it has been inserted into.  To alter this you 

need to decide how you want the text to wrap around the image. 

Click on the image to see black handles around its edge.  Click the Layout Options button 

and hover over the options to view the changes, click the option to apply the change. 

 

Alternatively, from on the Format tab click  in the Picture Tools options. Hover 

over the options to view the changes, click the option to apply the change 

Wrap Type Action 

In line with 

Text 

This is the default 

Square 
The text wraps around the image boundaries leaving a “square” of white 

space between the image and the text 

Tight 
Similar to Square only the space between the image and the text is 

reduced 

Through The text appears to go through the image 

Top and 

Bottom 

The text will wrap from the top to the bottom of the image with no text 

appearing down the sides of the image 

Behind Text As it says, the image appears behind the text 

In Front of 

Text 

The image will float on top of the text so you can move it anywhere on 

the page. 

Edit Wrap 

Points 

You can edit the wrap points on the image with this feature so that the 

image can be further embedded into the text.   
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Notice that once the image wrap type has been changed from In Line with Text, the 

handles appear white.  Try moving the image by pointing at it, holding down the mouse and 

dragging.  For some Wrap styles you can move the image to the desired location. 

Cropping 

Images can also be cropped (i.e. part of the image remove from view).  Click on the image 

and then click  from the Format tab in the Picture Tools options.  Position the crop 

tool over one of the handles around the image and drag the mouse to crop the image down. 

Before Cropping:             After Cropping: 

   

Corrections, Colour and Artistic Effects 

Click on the image and adjust the picture tools as required to achieve the effect you require: 

Feature Adjustments available 

 
Sharpen, soften, adjust the brightness and contrast. 

 
Alter the color as required. 

 Check out the various effects to apply to your picture. 

Rotate 

Click on the image and click .  Select the relevant option to rotate or flip the picture 

until the correct display is achieved. 

Picture Styles 

Initially images are inserted without borders.  Use the Picture Styles group in the Picture 

Tools to apply a Style, apply a Picture Border, Picture Effects and adjust the Picture Layout. 
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Reset Picture 

If you make a mess with manipulating an image you have inserted, click  to reset the 

picture back to how it looked when it was first inserted. 
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Track Changes 
When several people are collaborating on a document, usually one person “owns” 

the document and other review it and suggest changes.  The Track Changes 

feature provides the facility to see revisions made to the document without the 

original text being lost. 

To turn on Track Changes choose Review and click Track Changes.  Any changes made 

to the document will appear.  For example:  

 

 

Changing the Markup Display 

Select Simple Markup from the Tracking group.  The revisions will be 

hidden from view and comments will be displayed.  To redisplay then 

choose All Markup. 

 

Select No Markup to hide all revisions and comments.  Select Original to view the original 

document. 

Revision Balloons 

If you want to see the Revision Balloons in the document margins, click Show Markup 

and choose Balloons.  Select the display as required. 

 

 

 

 

Rejecting a Revision  

If a revision has been made that you do not wish to retain, 

click anywhere on the text and click .  Alternatively, if 

you want to reject all the changes, click on the drop down 

arrow at the side of the Reject button and choose Reject 

All Changes. 
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Accepting a Revision 

To accept a revision, click on the text that has changed and 

click .  Alternatively click on the drop down at the 

bottom of the Accept button and choose Accept All 

Changes.  

Next/Previous Revision 

To move between the different revisions in a document quickly, click Previous or 

Next as required.  

Adding Comments 

To add a comment, select the text you want to comment on, navigate to the Review ribbon 

and click .  A balloon with your user name will appear.  Enter your comments.  For 

example: 

 

To delete a comment, click on the comment balloon and click . 

 

To navigate through the comments, click Next or Previous in the Comments 

group. 

Reviewing Pane 

The Reviewing Pane can be used to list change by change the alterations and comments 

in the document.  Click .  The option to display the Reviewing Pane 

Horizontally or Vertically.  A new pane will be displayed at the bottom of the document or to 

the left with all the changes listed by Reviewer: 

 

 

 

 

To switch this feature off, click  again.  
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Track Changes Defaults 

You can customise your Track Changes defaults using Track Changes Options.  Click the 

dialog box launcher button in the corner of the Tracking group. 

  

Click Advanced Options from the Track Changes Options dialog box 

 

If for example, you were the only person reviewing the document you could assign colours 

differently to guide you through the changes you are making rather than leaving the colours 

used to define the changes by author.  Adjust as required. 
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Notes 
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mailto:csu.ittraining@nhs.net


 

 

Get to know us or 
get in touch 

mlcsu 

Midlands and Lancashire Commissioning Support Unit 

midlandsandlancashirecsu.nhs.uk 

 

 


